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1 Introduction 

The purpose of this manual is to provide a guide for using program FEMAP in 
connection with ATENA. Program FEMAP is a product of Structural Dynamics 
Research Center  (www.femap.com). It is a general program for pre- and-post-
processing of finite element analysis, and is used by many commercial finite element 
programs. ATENA is a product of Cervenka Consulting, and it is a special purpose 
package for nonlinear finite element analysis of concrete and reinforced concrete 
structures (www.cervenka.cz). In the case of using ATENA with FEMAP, only a core 
part of the ATENA system is used, namely, the finite element module AtenaConsole 

2 Components 

2.1  Script 

FEMAP offers an option of the script language Easy Basic, which enables to write user 
routines for applications and features, which are not possible in the basic FEMAP 
environment.  They can increase the capabilities of FEMAP application. This method is 
used for exporting the input data from FEMAP to ATENA as well as for the import of 
the output data from ATENA to FEMAP for post-processing. The scritps are also used 
to generate embedded  reinforcing bars within the finite element mesh. The scripts can 
be executed in FEMAP by choosing  an appropriate menu item from the main program 
menu.  

2.2 Data files 

TaskName.inp – The text input file for the analysis by AtenaConsole, where TaskName 
is chosen by the user. The file is created by FEMAP using the script CreateAtenaInput 
and is used by AtenaConsole.   
TaskNameXXX.res – The text input file for AtenaConsole for the definition of ATENA 
output quantities. This file is created by FEMAP, and is used by AtenaConsole. It 
controls which output data will be extracted from AtenaConsole binary files to 
AtenaConsole text output files.  
TaskNameXXX.out – The text output file from AtenaConsole. This file is created by 
AtenaConsole and is used by FEMAP by means of the script ImportAtenaResults. It 
serves for visualization of results. 

2.3 Configuration and other files 

Config.fem – This file is created in the working directory and contains global 
parameters of the finite element model and solution strategy (such as: TaskName, 
dimensions, numbers of elements and nodes, load steps, and other). 
Atena_Cur.dir – This file is created in the directory  containing FEMAP script files and 
it holds the current directory name. 
TaskName.cfg – This file contains data about curve numbers of reinforcing bars. It is 
created by scripts for the embedded reinforcement and it is placed in the current 
working directory. 

http://www.femap.com/�
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TaskName.cX - Data about reinforcing bars. It contains the weight coefficients of 
embedded reinforcement nodes or information about the connectivity of rebar nodes 
with the intersected solid elements. X is the curve number. The file is created by scripts 
for the embedded reinforcement and it is placed into the current working directory. 
TaskName.pX - Data about reinforcing bars. It contains the weight coefficients of node 
bars elements or data connectivity with solid elements. X is the property number. The 
file is created by scripts for embedded reinforcement. 
SpecVal.atf,  SpecVal.atn – Lists of names of available output variables for FEMAP. 
File is created by the script WriteAtenaOutput. 

3  Using ATENA-FEMAP 

The use of ATENA-FEMAP is shown in the flowchart in Fig. 1.  
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ACTIO  PROGRAM   SCRIPT    FILE 

FEMAP TaskName.MOD

CreateAtenaInput.bas TaskName.inp 

AtenaConsole 
TaskName.XXX

FEMAP WriteAtenaOutput.bas TaskNameXXX.res 

AtenaConsole 
TaskNameXXX.out 

FEMAP 

ImportAtenaResults.bas

TaskName.MOD
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Legend: 
PROGRAM AKCTION RESULT 
- FEMAP create finite element model file TaskName.MOD 
- FEMAP - script –
CreateAtenaInput.bas 

export of input file for 
AtenaConsole 

file TaskName.inp 

- AtenaConsole FE analysis binary file TaskName.XXX 
- FEMAP - script –
WriteAtenaOutput.bas 

defining output data file TaskNameXXX.res 

- AtenaConsole writing output data file TaskNameXXX.out 
- FEMAP - script –
ImportAtenaResults.bas 

importing output data to FEMAP fileTaskName.MOD 

Fig. 1  Flow chart of ATENA-FEMAP system 

As first the finite element model must be generated using the FEMAP environment. The 
details about FEMAP and its use can be found in the FEMAP manual. The special 
features concerning reinforcing bars are described in the Chapter 5. After completing 
model generation with FEMAP the system ATENA-FEMAP can be used for analysis 
and postprocessing. Operation of the system is controlled from the FEMAP 
environment. The sequence of operation steps is summarized below: 

1. Build your finite element model in FEMAP. Scripts for generating reinforcement 
elements Calculate2DRod, Calculate3DRod can be used if required. For 
two-dimensional problems it is however, recommended to use the program ATENA 
2D, which contains a powerful graphical user interface that simplifies many of the 
tasks, which are described in this manual. 

2. By executing the script CreateAtenaInput the file TaskName.inp (example: Test.inp) 
is created. The file Config.fem with a list of load steps (to be executed) is generated. 

3. Execute ATENA analysis by choosing the appropriate Run Option. File 
TaskName.XXX (example: Test.001) is created, where XXX is the load step number.  

4. Execute the script WriteAtenaOutput. It reads the list of load steps from the file 
Config.fem and creates the files TaskNameXXX.res (example: Test001.res). This file 
contains the information for extracting output data from the Atena binary files. 

5. Execute AtenaConsole (by Run Option). It reads the file TaskNameXXX.res and 
exports data from the binary file TaskName.XXX to the output text file 
TaskNameXXX.out.  

6. Import the output data to FEMAP by executing the script  ImportAtenaResults.  

7. Perform desired post-processing in FEMAP. 

The access to ATENA-FEMAP functions is made possible through the Menu. 

The tools are activated by choosing “Atena”, "SBeta" or "CCTools" menu (see Fig. 2) 

Fig. 2. The ATENA – FEMAP tools are in menu "Atena". The SBETA – FEMAP tools 
is in menu "SBeta". In the menu "CCTools" is the other scripts for Export and Import 
Mesh, Monitoring - evolution value, Prescribe displacements from file. 

Note: All files for the ATENA-FEMAP interface are text files. These files are editable 
and thus some of the operations described above can be replaced by a user file writing  
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or editing. 

 
 

 

 

 

Fig. 2  Main menu in FEMAP (top), ATENA-FEMAP menu (right bottom). 

4 Limitations 

Following limitations with respect to FEMAP must be observed. 

• Loading forces, or imposed displacements must be given in FE nodes. 

• Supports can be only in FE nodes and in directions of global coordinate axes. 

• ID number of Load Set and Constrain Set cannot exceed 999. 

5 Using FEMAP 

This chapter offers only a brief guide for FEMAP. For detail description please refer to 
the FEMAP User’s Guide. In the following are mentioned only some hints for a case of 
2D problem. 

Surface. Simplest region is a rectangle. Choose menu   Geometry → Curve-Line → 
Rectangle, enter corner points (bottom-left and top-right points). Choose Menu 
Geometry → Boundary Surface and Select All → O.K.   By this a region for generation is 
created. 

Material. In this menu material properties are generated: Model – Material. From all 
standard types only isotropic type is supported: Type → Isotropic. Only basic elastic 
properties can be entered at this place. Special ATENA materials can be entered by 
selecting Other types. Following ATENA material are abailable: 
• CC1DElastIsotropic  in template Elast Isotropic with Model ID 1 
• CCPlaneStressElastIsotropic in template Elast Isotropic with Model ID 2 
• CCPlaneStrainElastIsotropic  in template Elast Isotropic with Model ID 3 
• CC3DElastIsotropic  in template Elast Isotropic with Model ID 4 
• CCASymElastIsotropic  in template Elast Isotropic with Model ID 5 
• CC3DBiLinearSteelVonMises in template 3D BiLinear Steel VonMisess with Model ID 6 
• CCPlaneStressSteel  in template 2D BiLinear Steel VonMisess with Model ID 18 
• CC3DCementitious  in template 3D Cementitious with Model ID 7 
• CC3DNonLinCementitious in template 3D Non-Lin Cementitious with Model ID 8 
• CC3DNonLinCementitious2 in template 3D incr.Non-Lin Cementitious with Model ID 20 
• CSBETAMaterial   in template SBETA Material with Model ID 9 
• CC2DInterface   in template Interface with Model ID 10 
• CC3DInterface   in template Interface with Model ID 11 
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• CCReinforcement   in template Reinforcement with Model ID 12 
• CCCyclingReinforcement  in template Cycling Reinforcement with Model ID 13 
• CCSmearedReinf   in template Smeared Reinforcement with Model ID 14 
• CCSpringMaterial   in template Spring Material with Model ID 15 
• CC3DDruckerPragerPlasticity in template 3D Drucker Prager Plasticity with Model ID 16 
• CCMicroplane4   in template Microplane M4 with Model ID 17 
• CCCombinedMaterial  in template Composite material with Model ID 19 
• CCShellMaterial   in template Shell Geom.material with Model ID 21 

 

Description for these materials can be found in other Atena documents (Atena Input 
File Format, Atena Theoretical background). 

The FEMAP templates make possible to enter parameters of the mentioned models. 
However, there is always a second possibility to edit these parameters in later stages, 
for example in the dialog box Material properties in the script for Atena Input (see 
chapter on scripts, Fig. 8).  

Element Properties. Menu Model → Property.  Following items must be selected: 

Finite Element Types.  Menu Elem/Property Type – In this menu only following types 
are supported:  

• 1D element for reinforcing bars in the box  Line Elements → ROD   
• 2D element in the box                                   Plane Elements → MEMBRANE 
• 3D element in the box                                   Volume Elements → SOLID  

Material can be selected form a dialog box. 

Dimensions can be entered in case of 2D element – thickness, and 1D element – cross 
section area. 

Mesh generation. Variety of procedures is offered. Following items should be properly 
selected: 
         Mesh → Mesh Control –Size on Surface - Defines the element size on the surface. 
         Mesh → Geometry → Surface(resp. Hex Mesh Solids)- Selects the surfaces to be 
generated. If you want to use model the region using shell elements with the 
“ShellMaterial”, then check Midside Nodes. You will also need to generate quadratic 
Brick elements of topology Brick20 for it. 
         Generate the FE mesh using an appropriate dialog box. 

Boundary conditions are defined in the menu item Model → Constraint → Set. Only 
nodal supports are accepted by ATENA. For this we use Model → Constraint → Nodal 
and select concerning nodes and constraints. 

Loading is defined by the menu item Model → Load → Set. Only nodal forces are 
accepted by ATENA. For this we use Model → Load → Nodal and select concerning 
nodes. Supported loads are: Force, Displacement. 

It is possible to generate arbitrary number of “Constraint–Sets” and “Load–Sets” and 
combine then into load steps for ATENA. In this way (almost) arbitrary load history can 
be defined. 
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For ATENA analysis there are recognized three sets constrains. These constrains are 
given ID numbers with following rules:  

1. Loding forces and given displacement. ID numbering starts with 1001. 

2. Supports. ID numbering starts with 1. 

3. Embedded bars with kinematic constrains. ID numbering starts "MASTER-SLAVE 
definition in LOAD CASES" for "For each selected Curve separately" as curve 
ID+10.000, for "For ACTUAL Property ID" as property ID + 1.000.000. 

These ID numbers are automatically assigned to the approriate constrain types by 
scripts. 

When the finite element model is completed the script CreateAtenaInput is used to 
export data to the program AtenaConsole. 

6 Scripts for communication FEMAP-ATENA 

The purpose of the scripts is to introduce special features of ATENA into FEMAP and 
provide a data interface between the two programs. The scripts are programs in Easy 
Basic and are stored in the directory CCScripts. The scripts used for ATENA are listed 
in the following Table1. 

Table1. List of scripts for ATENA. 
 

Name Scope of Action Function description 

Calculate2DRod.bas Preprocessing Generates embedded bar elements for 
reinforcement in case of 2D mesh with 
quadrilateral elements. 

Calculate3DRod.bas Preprocessing Generates embedded bar elements for 
reinforcement in case of 3D mesh with solid 
elements. 

CreateAtenaInput.bas Preprocessing Generates input file for ATENA. 

WriteAtenaOutput.bas Postprocessing Generates definition of output data in a load step. 

ImportAtenaResults.bas Postprocessing Imports data from output file of ATENA to 
FEMAP. 

 

6.1 Generate Rod Elements 

These scripts are written for making possible the use of rod elements as embedded bars 
in ATENA for 3D element meshes. They calculate points of intersection of reinforcing 
bars with the finite element mesh and divide the reinforcing bars into series of rods 
embedded within the elements. These rod elements are considered as 1D elements in 
ATENA. In order to start the dialog choose the appropriate button from the 
Atena-Femap tool box (see Fig. 2). Then the sequence of dialog boxes follows as 
described further.  
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First the working directory must be chosen using the dialog window Current Directory 
as shown in the example below, Fig. 3. 

 

Fig. 3  Dialog box for choosing directory for generating reinforcement. 

A task name is entered using the dialog window Task Name as shown in Fig. 4. This 
Task Name will be used through the work as a basis of various file names. The check 
box "Old output format for MASTER/SLAVE" enables to define  kinematic constraints 
as weight coefficients of node bars elements or data connectivity with solid elements. In 
ATENA versions 1.1.3 and younger it is recommended to leave this box unchecked. For 
older versions it is necessary to select this option. The next field in this dialog is the 
“Default tolerance”. It is the default value for the calculation of intersection points 
between the reinforcement rods and the solid finite elements.  Next field is the 
possibility to read reinforcement curve information from a file: "Read Curve from file". 
The check box "Save continuously" is recommended when it is expected that large 
amount of reinforcement segments will be created.  

 
Fig. 4 Dialog box for entering task name and various reinforcement generation options. 

Before calling scripts it is necessary to define material property and geometry (“curve”) 
for concerned reinforcement. Supported geometry type is “Line”. Properties are 
assigned to the reinforcement using the dialog “Reinforcement Segmentation” as shown 
in Fig. 5  below. 
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Fig. 5  Dialog box for entering reinforcement properties. 

By pressing the button Select Elements it is possible to select a group of elements for 
checking their inter-section with the reinforcement bar. If the All Elements button is 
checked, then all elements will be checked for their intersection with the reinforcing 
bar. Initial ids for the generated rod elements and their nodes can be specified in this 
dialog as well. 

In the input block "MASTER-SLAVE definition in LOAD CASES" it is possible to 
select a rule for the definition of load cases, which are used for connecting the 
reinforcement nodes with those of the solid elements. After pressing the button OK, 
new nodes and truss elements will be generated. These newly created reinforcement 
nodes must be connected to the rest of the mesh. In ATENA this is accomplished 
through a special load case, which contains commands for tying the reinforcement 
degrees of freedom with those of the solid elements. A separate load case can be created 
either for each curve (the check box "For each selected Curve separately") or for each 
property (the check box “For ACTUAL Property ID”). The ID of the created load case 
is calculated using the following rules:  

• for each curve separately - ID = curve ID + 10.000 

• for actual property - ID = property ID + 1.000.000 

The tolerance is used for the calculation of the intersection points of reinforcement 
curves with the finite element model. The recommended value is about 1-5% of the size 
of the smallest finite element. 

By pressing OK the generation of rod elements for given lines in the list is preformed. 
For next reinforcing bar this dialog can be repeated with another properties (List Curve 
number, Rod property ID, Selected Elements, Initial ID for Nodes and Elements). By 
pressing “Cancel” the rod generation is terminated.  

The connectivity between the generated rod elements and the underlying FE mesh is 
stored for each bar into a file with the following naming convention: TaskName.cX, or 
TaskName.pX, where X denotes the id of the reinforcement curve, or property. The list 
of curves, or properties for which rod elements were created is stored into a file called 
TaskName.cfg. This file is totally regenerated each time this script is executed. When 
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ATENA input file is created, only the curves listed in this file will be included into the 
solution. This means that every time this script is executed, it is necessary to create the 
segmentation for all reinforcement curves that should be included in the model. In other 
words, this script should be executed only once for a given model. Otherwise the user 
should manually remove the generated reinforcement nodes and elements from the 
previous executions of the script. 

This program can change contents of the files Config.fem, Atena_Cur.dir and creates 
the files TaskName.cfg, TaskName.cX, TaskName.pX. 

6.2 Create Atena Input  

The  purpose of this script is to create a text input file for ATENA based on the FEMAP 
data and additional data special for ATENA. To start the dialog choose the button 
Create Input from the Atena-Femap tool box (see Fig. 2). Then the sequence of dialog 
boxes follows as described further.  

The working directory can be chosen in the same way as described in the previous 
script, Fig. 3. Usually the same directory for all files is used. The basic parameters for 
the data interface are set through the dialog window Initial Option, Fig. 6. 

 
Fig. 6 Dialog box for data basic parameters. 

 

Task name can be maintained unchanged. The dimension is 2 for 2D problem and 3 for 
3D problem. Title can be any description.  

The check box "Old output format for MASTER/SLAVE" must be selected if you have 
selected this check box for the generation of reinforcement with script 
Calculate3DRod.bas or Calculate2DRod.bas (Fig. 4), because script reads just 
previously generated kinematic constraints. Old method defines weight coefficients for 
each reinforcement node and degree of freedom, while the newer method requires only 
the nodal numbers, to which the displacements of the reinforcement nodes should be 
tied.  

Next dialog, Fig. 7, offers an option to check for an existence of  unused nodes. A 
similar option exists also in FEMAP and it is recommended to use it for the removal of 
free nodes.  
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Fig. 7  Dialog box for counter clockwise element numbering. 

The material properties entered in FEMAP can be viewed and changed in the dialog box 
Material Properties, Fig. 8. 

 

Fig. 8  Dialog box for viewing and editing material parameters. 

Supported material types (CCSBETAMaterial, ...) as well as parameter identification 
names (E, MU, ...etc.) can be found in the document Atena Input File Format.  

In the following dialog box an option of strain definition can be chosen, Fig. 9. The 
option NONLINEAR means large strains  (Green-Lagrange strains), the option LINEAR 
means small strains (engineering strains). 

 

Fig. 9  Large and small strain option. 

The next dialog offers an option to check the numbering order of element nodes in 2D 
elements, Fig. 10. ATENA requires a counterclockwise numbering of element nodes. If 
clockwise numbering is detected FEMAP performes a renumbering. (This happens only 
seldom.)  

 

 

Fig. 10  Check element node numbering order. 
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Writing ELEMENT GROUPs: 
The following tables describe the element type and group numbering that is created by FEMAP-ATENA 
interface for various element groups. 
 
Element Name Element 

Type 
L_ROD 1 
L_BAR 2 
L_TUBE 3 
L_LINK 4 
L_BEAM 5 
L_SPRING 6 
L_DOF_SPRING 7 
L_CURVED_BEAM 8 
L_GAP 9 
L_PLOT 10 
L_SHEAR 11 
P_SHEAR 12 
L_MEMBRANE 13 
P_MEMBRANE 14 
L_BENDING 15 
P_BENDING 16 
L_PLATE 17 
P_PLATE 18 
L_PLANE_STRAIN 19 
P_PLANE_STRAIN 20 
L_LAMINATE_PLATE 21 
P_LAMINATE_PLATE 22 
L_AXISYM 23 
P_AXISYM 24 
L_SOLID 25 
P_SOLID 26 
L_MASS 27 
L_MASS_MATRIX 28 
L_RIGID 29 
L_STIFF_MATRIX 30 
L_CURVED_TUBE 31 
L_PLOT_PLATE 32 
L_SLIDE_LINE 33 
 

 
 
 
Element Topology 2D 3D 
Line2 0  
Line3  1 
Tria3 2  
Tria6 3  
Quad4 4  
Quad8 5  
Tetra4  6 
Wedge6  7 
Brick8  8 
Point1  9 
Tetra10   10 
Wedge15   11 
Brick20   12 
RigidList   13 
Pyramid5   14 
MultiList2   15 
Contact2   16 
 
(Solid) Property is identification of Material 
and Geometrical specification (for example: 
2D element type has geometrical property- 
thickness, for Truss element is geometrical 
property-Area). 
 
Calculation Constant Value 
K_PROP 10000 
K_MATE 1000 
K_ETYP 100 
K_ETOP 10 
 
 
 

The element type id is generated using the following formula: 
 
ELEMENT_TYPE_ID =Elem_Type*K_ETYP+Elem_Topologie*K_ETOP+Elem_Property*K_PROP 
 
In ATENA each element group consists of elements of the same type using the same material. The 
element group id is calculated using the following formula: 
 
ELEMENT_GROUP_ID = Incremental Index (for 3D Element Group) 
 
MONITORING 

Dialog of Monitors has a few edit options. First is Name of Output monitor, next is 
Location of monitor, next is Data list and last is Item of Data List. 
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Parameters of analysis are set in the dialog box Loading History, Fig. 11. The meaning 
of parameters is clear from the screen. In this version only Static analysis is supported. 
Iteration method Newton-Raphson is suggested for the problems with given loads or 
prescribed deformations. In cases of ultimate load analysis and post-peak response the 
Arc-Length method is recommended. The parameters of nonlinear solution control the 
iterative process. Residual Error and Absolute Residual Error are related to force 
equilibrium. Displacement Error is related to displacement changes and Energy Error to 
energy dissipated in the current iteration. Iteration limit is the maximum number of 
iterations in load step. If reached, the solution has not converged under given 
tolerances.  

Load case ID is increased by 1000 for the purpose of transfer to ATENA (example: load 
case 1 in the Input file has ID=1001). The load case ID is only a name (string of 
characters) and this method does not have any numerical consequences. The 
reinforcement is included in this dialog, because it makes possible to activate 
reinforcement in later stages of load history, for example is cases of structural 
strengthening or prestressing. Note that the scaling factor is ment for a value of force or 
displacement and thus in case of reinforcement is irrelevent and is considered always 
1.0 regardless of user’s choice.  

The item Store data for every STEP makes sure that the binary files in ATENA contain 
data form all load  steps. These data are needed for text output or post-processing. If 
text output or post-processing are not required this box should empty. By pressing OK 
the load steps in the dialog box are added to the steps previously generated. 
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Fig. 11  Dialog box for load history and solution parameters. 

In the dialog box Analysis, Fig. 12, it is optionally possible to modify the input file for 
ATENA using the button Edit *.inp file. The analysis by program ATENA is started by 
pressing the button „Atena Console Analysis *.inp file“, or „Atena Win Analysis *.inp 
file“. 

 

 

Fig. 12  ATENA Analysis option. 

This script modifies files Config.fem, Atena_Cur.dir, and creates file TaskName.inp. 
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6.3 Write Atena Output 

The purpose of this script is to define data which should appear in the text output file 
from Atena. Prerequisites are binary files TaskName.XXX, which contain data from an 
analysis. To start the dialog choose the button Write Output from the Atena-Femap tool 
box (see Fig. 2). Then the sequence of dialog boxes follows as described further.   

First two dialog boxes for directory and task name are opened in the same way as in the 
previous scripts. Usually directory and task name should not be changed for the output. 
The next dialog box Output Data, Fig. 13, is used for definition of output data. The 
available load steps appear in the box Load Step Binary Files. If output data for all load 
steps should be generated the box Generate all *.out files. should be selected. 
Alternatively, only one load step can be selected form the list. New .out files are created 
and existing .out  files are replaced by new ones. In Standard Data the items required for 
the output should be checked.  

In the option Special Data additional data can be entered. By pressing the button Fill 
from Atena  it is possible to read all data items from Atena. Selected data, or all data, 
can be deleted from the box and only data types needed for output should be left. The 
buttons Add User Data and Edit are not active.  

After pressing OK the script WriteAtenaOutput is executed. It generates the file 
TaskNameXXX.res  (for definition of output data). It automatically generates also output 
files by executing ATENA only in case that box Generate all *.out files is checked. In 
other case the file .res is generated only for one load step and output file generating is 
preformed using the next dialog box Output, Fig. 14. This makes also possible to edit 
the .res file if desired.  
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Fig. 13  Dialog box for output data. 

 

 
 

Fig. 14  Dialog box for creating output files. 

This script can modify the contents of the files Config.fem, Atena_Cur.dir. It creates the 
files TaskNameXXX.res and TaskNameXXX.out. 

6.4 Import Atena Results 

The purpose of this program is to import data from ATENA output files to FEMAP. 
Prerequisites are text output files TaskNameXXX.out, which contain output data form 
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analysis. To start dialog choose the button Import Results from the Atena-Femap menu 
item (see Fig. 2). Then the sequence of dialog boxes follows as described further.   

First two dialog boxes for directory and task name are opened in the same way as in the 
previous scripts. Usually these parameters should not be changed for the output. The 
next dialog box Input file name is used for selecting needed output files, Fig. 15.    

 

 

Fig. 15  Dialog box for output file names. 

This script can modify the files Config.fem, Atena_Cur.dir. It reads data from the files 
TaskNameXXX.out and include them in the file TaskName.mod. 

If  it is required to read several output files, their number can be specified in the dialog 
box in Fig. 15. If for instance a number 3 would be specified Fig. 15, then the files 
“konzola004.out” to “konzola003.out” will imported into FEMAP. It is important to 
note the results from the first load step that is imported into FEMAP should contain all 
types of possible input data, otherwise an error message may occur during the data 
import for subsequent files. 

7 Final recommendations 
Viewing of  results depend on the type of ‚vector of result‘. When nodal or elemental 
results are to be post-processed, it is important to select an appropriate output type. For 
instance, in the case of  vector type ELEMENT, it is necessary to be selected in the 
menu "View" → "Select" → "Deformed and Contour Data" → "Contour Options" → 
"Contour type" → Elemental. Without an appropriate selection of this option the display 
of data could be incorrect in FEMAP. 
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